COMBINED TECHNICAL SERVICES EXAMINATION
(DIPLOMA/ITI)
COMPUTER BASED TEST
DATE OF EXAM: 15.09.2025 FN
PAPER - II
TRADE- ARCHITECTURAL DRAUGHTSMAN
(ITI STANDARD) (CODE: 531 )



What appears below the section line to allow flipping the direction of
view?

Lirfranal udl g g‘,]sm&mu; e, oensg&ss 19fle Gamiigeb &@va @T GOTGoT
Canermélmg) ?
(A) Rotate button (Iﬂ/Arrow symbol
FpHm Gursgmer Sby@DH flarard
(C) View cube (D) Toggle marker
SHFG|TE®G HTa S LOTTESENT [OmH M)

(E) Answer not known
ailan. . @sfluaidame

Which file format can be used in the “Create from import” method
for topo surface?

CLrGursi:Cuevds@ — “Create from import” wepule abs Camiiy
Ul GUThIGENET L6 (&SHEILD 2
(A) PDF and JPEG (M)WG, DXF, DGN
PDF womiw JPEG DWG, DXF, DGN
(C) DOCX and XL.SX (D) STL and OBd
DOCX whgin XLSX STL womw OBJ

(E) Answer not known
aflen Qgflwelevena
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3. In the fill pattern dialog box, which option must be selected for
concrete hatch?

Fill pattern sceajurid GQuiguie sradil aprlé o@wss b
elmliLsens Gsirea| Waiiu Geauermb ?

(A) Hatch type (B) Background fill
QDL &F GUENS Weranaf Hlyiiy

(CVDI'afLing (D) Leader style
QU6 GILIT GuEnLed

(E) Answer not known
cllev Ggflueieane

4.  To mark the length of curved wall, which dimension tool is used?
auaneThs Fauflear ofléd Bersens GMéss by uflorars smedl LweTU(Hss

LB Emal?

(AQ/ Arc length (B) Linear Dimension
fled Barid Cpflwe uiflwrewr b

(C) Diameter Dimension (D) Angular Dimension
ol Ltb uflbmesrind Gameawr LflmemnTin

(E) Answer not known
aflanL Qgfweiaana
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What tool lets you adjust stair riser count and stair width directly in
the model?

ordfllles Lgss Haelld aareatlgms wLHnL swsms Crrqurs sfeww
ThS G(Hell 2 msenaT eSS ng 7

(A) Move tool (B) Edit sketch tool
B&ETHED H(Hae Hmasad ble & sme
((]9/ Direct manipulation grips (D) Type selector
Crre. evswm@ense 19q 6T suanas Gaired

(E) Answer not known
sflen_ Ggflweldeney

Which of the following is not a category under stair “Type
Parameters™?

Qemeupeameupmled gl LigEs () eUend eTe(HSS6T eTaTLS6 &S 6Uens
DGR ?

(A) Calculation rules (B) Construction
sanaSLl () alldlsar &1 (HIreTid

(C) Supports (M\’all types
ST &6 FaUT GUMSSHET

(E) Answer not known
ellen Gsflweléeney
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Which tool 1s used to compute gross building area and rentable
area?

Qrss sl UTLILETa] WHDID eUTL®&EE el dsmill LG semrésl
b5 S(hell LwatL@RSDe 2

~1]

(A) Room tool (B) Volume tool
2| &(Hell GamEd sme

(())/Area plan tool (D) Floor tool
UFriLene] L. sme 5enT &(Hed

(E) Answer not known
aflen GsMuieilerenay

8.  Which tool is used to divide a room into parts without adding walls?
gaufrgamer Ceis&ambd eup empanw @ran® u@dseams Wllés by emel

LiweTU (& ms) ?

(A) Room tag tool (B) Split element tool
slenn GHEClsrd Hmef ALY 2 midiy s@med

(Ci/ Room Separator (D) Area plan tool
<ieom AMcimer UGS SlLs s@med

(E) Answer not known
eSev GgNwaeldame

9.  Which of the following is not a valid column property that can be set
in the proportion pallete?
HereupeuareupPled b LMILSGET SLled) S@bESImll CFbQILiguimEL
GITE8T LIGHTL| <H{6DeD ?

(A) Base level MOof type
Bilg LILI6nL ﬂas)eu FaMI CUENS;
(C) Top offset (D) Base offset
- TRNA AL (W Sl UL Dol GlF

(E) Answer not known
aflew Csflwaidenay
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10. Which method is not used to create tloors in Revit?

Revit & gevysamar 2 (maunds abs wapn LwertHHgLuLailldeamen ?

(Ai/ Floor by mass (B) Floor structural
Hlanm =i liLiant udle S6MID &L anLLL

(C) Floor by face (D) Floor architecture
(IDEEHTED Feolf SETLD &L gL 5FHEME)

(E) Answer not known
alen Gaflwelwena

11. In roof by footprint, what does the overhang value control?
@sLuTe® sy  aeaudd  blgs Geragméeh by amsd
s (HULRESHS DS
(A) Thickness of the roof

SaenTUl6T Sig 06T

(Vpr()jecti(m of the roof outside the walls
FousEnsE euatGu amenrufle HLiq L

(C) Slope of the roof

saenudlen Fmiey

(D) Height of the roof

gnedyudlelr = Wy

(E) Answer not known
sflant Gsfluafdana
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12. The default shape of tread in Revit stair’s is
Revit—@gé ugssl () panunmgsaller @uelblae aulgalld 6rg ?

(A) Round (B) Curved
QUL L DTG LT DD
(C)/ Rectangular (D) Wedge shaped
C&6ia1s @llgailh 2pUIL] @UleGULD

(E) Answer not known
clenL Gsfluieiceane

13. Identify the parameter controlling narrow glass-divider strips

Gndwu  saraming-9fuured  Spmsmers  sLEUUESSID  l6Te|(Hanel

DI@®L_ITETID &TET6 LD

(AY” Muntin (B) Trim
(LpeiTig 61T g 1flD

(C) Height (D) Thickness
o Wb &lq LDGHT

(E) Answer not known
sllen Qsflusldeana

14. Choose the command for activating the mirror — draw axis tool

Arr—tgqm  o&fed  smedlanw Crweu@RSEIUSDSTET S DeTeis

Caiipbls B &seb
(A) MM (B)/DM
(C) MD (D) MC

(E) Answer not known
alenL Qasifluelebena
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16.

Choose the tab for adjusting dimension setting in walls.
seutaate uflbrem Sawlisamer FildFuagparar G &g CarbhlshHasa|b

(A/Manage tab

@m@m% CLu-flreundl G

(C) View tab

srers GL Ul

(E) Answer not known
sflen Gatlweilrena

(B) Insert tab

G&mE G
(D) Modify tab

wrhdluesn Gl

Select the feature creating walls along existing guides.
a:r;_f;&sem@su o GTeT mgS]asrrLLq_aa@L_ebT GOUTEMET 2 (HAUMGEGD DDISMGS

CarmbshH&sea|b.
(A)/P'ick lines
& enevetreiv
(C) Are tool
<,7& S(mell
(E) Answer not known
ellenL Qg flweildane

(B) Fillet tool
solilbevl &(medl

(D) Ellipse tool
eTedlue &(medl

Select the function that adds structural layers to a wall design.
sgalff  allgeuanoliféd &L aniolil QsGsmers (Gars@h  Gauwie Im enL &

Cuiih 0l & (Hd&6LD.
(A)  Apply

Uweru (HSg) (Apply)
(C) Merge

epaiTihl enamT &5 6

(E) Answer not known
sfllent_ Ggtwalerenan

(Dﬁnsert

Gl

(D) Attach
Baoanss
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18. Identify the shorteut for Split Element.
Split Element ssrer gmise anflenul @ wimeTh srama]ib

(A) SF BYSI
(©) SE D) SN

(E) Answer not known
e GgMwucilweama

19. TIdentify the elements defining project context like Grid and Level.
Grid wpmib Level Gumarp St @pae cuapums@h snpsemer <5ienL WreriD
SIT680T 6L LD

(A) Model element

Sl erevGlwedi

(B) View specific element
@OIUEL L reoblbeaTenL. LMTT&E&Ha]D

(O)/Datum element
GLL1b erevlesert_
(D) Option
el (mriLILh

(E) Answer not known
adlenL Gaflweildene
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20.

21.

22.

In each tab, there are several panels available in Revit and each
panel has some tools in it is known as

Revit -@o galeaummp sreudgib uw @ussd GQ@uugiler geubenms

Gpailauid e spalaer o eTamar eTarig eTaTar e ALPSHILIGS S ?

&Y Ribbon
fllILeT

(C) Menu
Qe

(E) Answer not known
aflen Ggiflweiwens

(B) Side bar

LSS 1g

(D) Status

0L S )

Identify the file type for modeling components.

Component sever wrdfwuméed CETUIL QUG 26 _WITETD GTeaTalld
& & e 8

(A) Project
LigreysL

(C) Section
ey

(E) Answer not known
elilenL Qg flwallcvene

(M‘amﬂy

GEHDLID
(D) Schedule

U | @G e

A key term in BIM that has objects and assemblies that have
schedule and time constraint data added to them.
UL euenenl WHNIW &Sredsl. sLBUuuUrlk  Sreyser

Qumgplaer  wHmLD

=g Qaflsesar Gersstiu@n BIM—@é apaduwrar ugih earg?

(A) 2D

(CW” 4D

(E) Answer not known
aflen Glgilwailerene
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(B) 3D
(D) 5D
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23. The users generate constructing details such as plans, sections,

schedules directly from the model is known as
prdflulled @mbg slgl efleurmamer Chrgwns 2 (heuTsEL Cewapa

QU eTeie?

(Aﬂ/ Documentation
<, eUeTIL (N$&6)

(C) Animation
el Cagen

(E) Answer not known
Aen Ggflwaideane

(B) Calculation

SenHE ()

(D) Fabrication

s CUUMNCH e

24. Select a platform that supporting BIM workflows.

BIM uesfluiumieseear <gfa@n sasass CammbblshdEsayn.

(A) Photoshop
(C) Premiere

(E) Answer not known
sflenL Gsflweicens

(Bﬂ{evizto

(D) After effects

25. Select the setting that determines specifying wall level placement.
GO L saurflae @Lsms Hliaruisen smopliaus Coibbs(saeyb.

(A) Height
2 1ifLh

(C) Thickness
&g LD GbT

(E) Answer not known
e Qgiflwellcvena

531-Trade Architectural and
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ENRANIALT



26. The standard height of a human from floor to top of head while
standing and working is
Blery CaranGL Geauene el Gurg sayulledmhs seowwler o &8 ey
QoTEs o wimh arerar?

(A) 1800 mm (1‘:»/1930 mm
1800 5.8 1930 5.8
(C) 1500 mm (D) 2000 mm
1500 1.8 2000 151158

(E) Answer not known
cllent GlgMluieiaana

27. The anthropometric data does not consider
wre el srey durgeurs amss HHsdld Careararng

(A) Posture (B) Clearance
Canyenet <@gl

(G/Room size (D) Reach
SHenDUllell eey DL LD H6TEY

(IZ) Answer not known
sllenL Ggflwalwana
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28. For a comfortable sitting posture, how the thighs, legs and feet be
positioned? .
@ BUT EImas o L arhausD@ Sfeuflel GFranl saT, STOSE wHNHID LTSS
oleueunml BHlenaBlmssiiui Geuetr (b
(A) Leg stretched forward, feet dangling

sidser peiGensdl Sy, srdwsd Qgmusul Geusd (Hb

(B')/' Thighs horizontal, lower legs vertical, feet flat on floor
GlgreL&eT flenL bl L ons, & srasar Cok@dsrs UTghisea smputld
L Geuedsr (i

(C) Legs Crossed

FTO&ET GHN&&TS @) (héEs Ceuds (b

(D) Knees raised above hips
(Ppasroser @OHUysSE Coons e widsuul. Geus(hib

(E) Answer not known
e Glgflweldene

29. The working surface height for writing, when a person is seated

upright, should be
@@ BuT Curms o Ll smipdlhé@h Gurg, eawgeusharer Ut Cweneuler
2 Wb ereueuena @\(m&s Geuar(hib ?

(A) Below knee level (B) At waist level
pLemisTed wiLsHneE SCLp @6y bl gHd

(Cﬂ/ Above elbow height (D) Shoulder height
PprEas 2 WrssnE Cobe Corearulen 2w

(E) Answer not known
afilant . Gstluieieana
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30. The recommended width allowance for a seated person, including
clothing and movement 1s
2 U MiGAGLLGIMESE @l IHmid Guissd =L uflbgerssiul L
GODBSH LT SHFOLD 6T6T60T ?

(A) 24 inch (B) 30 inch

24 R 30 @b
(C-)/ 28 inch (D) 26 inch

28 <9 [hl (&6VLD 26 @b

(E) Answer not known
v Glgflueilvena

31. Identify a direct consequence of poor ergonomic workspace design.
Cumrsnrer uetlgspeluid veafludl angaiamninfer Crry lepera] & emaTel T

@) (&GS ?
(A) More team work
@ifls G riLeni

(B) More loyalty
<5ls eilgFeursid

(C) Higher productivity
<28as 2 HusSH e

(T))/ Low morale, absenteeism
GODHS e 2 mid, Liemt& @6l Tenin

(E) Answer not known
aflenL Gsflweldena
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32. The book “Divina Proportione” was written by
“Divina Proportione” sémm yssssos aupdueur?

(A) Leonardo da Vinci (B) Le Corbusier
SCWrenmiGLr L eflend el s &lwi

(C&/Luca Pacioli (D) Vitruvius
s umdGuimed el (meflwie

(E) Answer not known
cilenL Ggflweldeae

33. The role of Anthropometric database is to
el eiluie §re|seTrhisetlaT LikiE ereman?

(A) Predict Market trends (B) Stores sales data

shens CUTEHGHMET SHanllbaab dpuener srensué Caulléseybd
(C.V’Providc body measurements (D) Improve branding

2 L6 eTel(HEEET GULMhISE]|LD ey mians GuibUR$sen

(E) Answer not known
len Gasfluerena

531-Trade Architectural and 16
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34. The draughtsman use revolving stools due to its
GUENTEUTETTSET &HLPaId BTHa&TlEmeT LweTU(RSgleushanear (padlw sijemib ?

35.

(A) Comfort
= UIEY

(B) Cost
Glgeey

(G)/ Access to all the edges of drawing board

(PP UDTEHD LUQOEHFFESTET B @lFH6)

(D) Better posture
Spng Comranar

(E) Answer not known
eflent Ggiluiefaena

The furniture commonly provided to typists are

s &x Geluersense Gurgers

cupEsLILGHSDE ?
(A) Fixed chairs

Blaveowirar prosmel&seT

((VlAdjustable chairs

gl Glaigniqul BrHsTelseT

(E) Answer not known
denL Gsflweldwena

17

ahs  eueswner furniture’

(B) Stools

NG

(D) Bean bags

Sem enuseT
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36. The final surface treatment given to a muram floor
(prid sTEE@ aulpmslIuB D @mnd Cionurin Adfsme aerar

(A) Polishing with oil

eramenamTmed Lmedlen GlFlise

(B) Whitewash coating
QoeudTeneTwig §s LiFs

(G/Mud—cow dung mix application
Cop—on_ (& grewibd Seeney

(D) Brick tile finish
Glemiged F e

(E) Answer not known
allen Qs flweilerene

37. The minimum thickness required for a Timber panel in a door frame
EHUF FLL&SSD DILURMmasEE Comeuner G@DbsLLF Sl DEIT eT6ime ?

(A) 10 mm (B) 15 mm
10 .8 15 8.8
(Ci/ 20 mm (D) 25 mm
20 8.8 25 9.8

(E) Answer not known
eflen Gaflwaidana
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38. The distinctive gateway structure of a Pandya temple is known as

39.

40.

oy uramqw  Ganldseiiar sefisgieunrer mevpamis ey eTatT)
Snp&slLpE g 2

(A) mandapa (BVgOpur‘am
LD@TL L 11D GCamyrb

(C) shikara (D) vimana
EED el menrb

(E) Answer not known
ellen Qgflweldane

The small monolithic shrines at Mahabalipuram, carved from
granite are termed as

arualyrsgler drmamar Lrd QsgssiiulL APy ghenssd Gsreldosdr
GTEITGT GTETMI <2HEMLPSHLIL (Dl mgy 2

(A) Vimana (B) Mandapa
edlomeih LDGHTL_LILD

(C)/Ratha (D) Gopura
THLD Gamuyb

() Answer not known
eflen Gaflwelldana

What helps to counter the outward thrust of high vaults in Gothic
cathedrals?

Cardlé sbljisafieo odrer o wynrer sumearasafid Qeueflii 2_B8IEana)
erdligg GumITL orgl 2 seydlng

(A) Thick walls (Eﬂ’ﬁyiﬂg buttress
Slg TLOMTED Fr6L TG 6T CUANGHITE) @ IGHETE

(C) TIron bars (D) Wooden beams
BBy SEbIYser L& SHenmseeT

(E) Answer not known
llent_ QaMuiefdveney
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41. Element used to shape mesh objects by dragging
@puuger pped Gwey QUTIEBLS@m6r qligeuanbdsll LWaTLHSSUILGEDn dam

(A) Cameras (B) Lights
Cayrsser SleTd & & 6T

(G{ Mesh sub-objects (D) Textures
(el ganawll GummLseT G anipioiger

(E) Answer not known
cflan QgMuialdana

42. Tdentify the basic components of a mesh model used to define 3D
shape.
3D ageugms warupsst Lwau@SsLILGDL Oweay wrARuler g liLian
FMIBEDET J{EHL_UITETLD &T68T.
(Aw)/Vertices, edges and faces
Cemi@ g a6, efalibysen WHHID (P& RIS
(B) Points, curves and surfaces
Lerafladr, euepereyser whmind Cohuriiyser

(C) Nodes, beams and plates

(peparser, el L BIGET HMID L OIEET

(D) Pixel, lines and layers
Wagoaer, Car@aer wHmin 2D EGsE

(E) Answer not known
sfleni G@sMwelcrens

531-Trade Architectural and 20
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43.

44.

AUTOCAD offers two types of surfaces as mentioned below

&G @MUl lul fererug <yl CLrCsl @reamp euenswmer GohHUrlLsmen
QuprIGHDg

(A) Polygonal and mesh

LiewGamant opmid Glinag

(B) Solid and wireframe

> apmbs oMb awumidCrn (wireframe)

(C/Procedural and nurbs
Qawaqpenm (Procedural) whmib (nurbs)

(D) Isometric and orthographic
aGeanrGl & (Isometric) whmibd <,iGsréymis (orthographic)

(E) Answer not known
aflen Gasfluaidana

Nurbs surfaces in AUTOCAD are used to
2 CLrCsqe® =2der  Nurbs  Gupupiyser  Gérameiarahbl b
Lweiu (gL R dlempe

(AWSculpt with control vertices

SLHUTL(H (PMETHET (el 2 (HeUa DGS6)

(B) Perform Boolean operation
eSlwer Gewdurpaamers CQaiiwe|ib

(C) Create solid volumes only
Sliorer Qem@dlaamer o (HeuTése] b

(D) Apply textures only
DenLUILEE WL (HID Lweiu(hdsed

(I) Answer not known
eflen Ggflwelleeansa
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45. By which action 3D solids are created in modeling software?

wreedi  QuearQur@eflss 3D HLoCQurmeser  ems  Gewerd
o (HeUT&SLILI(RSlerman

(5«/ Lofting (B) Rotating
SI&G5 FLOOH M H6D

(C) Cropping (D) Painting
Cegid@se suaiTeRTlD U (HHD

(E) Answer not known
cllenL Ggilweidene

46. ldentity the property that is not associated with solid models.

& LDNQI‘H&E@I_@T CsrLmYeenrs LT SHeneT 6L WTETLD &6 6y Wb

(A(Surface texture (B) Mass
Guhurlil] el hHlanm

(C) Centre of gravity (D) Moments of inertia
FETLIL] @DLOLILD Blavang Slmuuss e

(E) Answer not known
sflenL Gsflweleena
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47.

48.

How designer can take advantage of Nurbs modelling in 3D design?
3D eugeuenwiber Nurbs wriain apepmenii @ ailqaiabriLmeTt sTeueurm)
LTSS CEmeTer (Ll ?

(A) By converting mesh to solid
Gwemay S Cungerns LIHNEIGSET ApeLD

(B) By using only mesh objects

Gwey Cum@plaamer WL (HIL LWETURSEIGISET pLHaLD

(C&/ By converting a model to a surface
@@ wrdlflanw CuodUgriirs DTHHGISET eLpELD

(D) By creating wireframes
QUWIT SulIGTIDEEET 2 (HeUTEGEIFET FLPELD

(E) Answer not known
aflent Gl flwieilerane

In 3D Text if “Extruded” is disabled, how will the text appear?

3D Text @& “Extruded” @pLésiul 4 @phsrd (2ay) apsgiébsen sreueur)
Camermib 2

(A) Invisible (M lat without depth
FHeTanlds@Hs Csfluims) DbOD @OEMDED HU L ULITaE
(C) Rotated automatically (D) Multicolored
sratrsGel &LpEhLD LIGD @LI 60T GooT bl &1

(E) Answer not known
silen Gz flwsidena
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49. Identify the menu option lets you insert 3D lettering into your
model.

2 g6 wrdlfludle 3D ar(psgimene. Garas iaodls@h Gva) eHmiisms
@jﬂﬂlﬁﬂ@&;

(A) View > Shadows > 3D Text
(B’/Tools > 3D Text

(C) File > Export > 3D Text

(D) Window > Preference > 3D Text

(E) Answer not known
eflenL Ggiflwaildeane

50. In Sketchup model identify the tool used to apply materials in wall.

Sketchup wrdfller  sauflds Qumprsamars Usl  UweaTUHSSUILELD
S(HHlen BIenLWITETLD SHiremn e b

(A) Texture (BY Paint
QL &averr Gl egor_

(C) Color editor (D) Material picker
SO GTig I L 1T Qg flwed Q&esT

(E) Answer not known
aflan QsMuiellcrana

531-Trade Architectural and 24
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51.

Choose the additional step required before first use of layout (or)
style builder after installing sketchup.
Sketchup flpeiiw Qo layout siowg style builder & wseaipeapwns
LweTU(REs (per Caemsuurear (s s smss Csiey Celis.
(A) Restarting computer

genilefllenw wm CarLssn Clewige

(B) Downloading templates
QLwuleari@amar udalpssd CFwgD

(C) Installing windows updates
cllarCLmev Lgubiyseaner Blmicse

(D/Activating subscription plan (or) trial
shsT SILID Jdag grue bFudufisgsss

(E) Answer not known
aflant CsMuieferans

25 531-Trade Architectural and
Draftsman
[Turn over



52. Match the following (sketchup hardware and Software

requirement) :

Qummsgs (sketchup emmit_eur whmib Quar@unmer Caamaiser)
Column A Column B
LI 1quied A Lt iquied B

(a) Minimum RAM 1. 8+ GB
Goppzuls RAM 8+ GB

(b) Recommended RAM 2. 4GB
ufibgiemrsstiu L RAM 4 GB

(¢) Recommended graphics memory 3. 512 MB
uflbgleng&ariuc L &yriigey Gl 512 MB

(d) Minimum graphics memory 4. LGB
G@mpbsULg Fymiseay Gwwd 1 GB

fa)l (b} te) ()
o 2 1 4 3
i e T 4
€ 1 2 4 3
D) 2 1 3 4
(E) Answer not known

clilenL Qgflwaideae

53. Sketchup PRO requires which version of the .Net Framework to

function

Sketchup PRO Qswéur epg .Net Framework udluy Cemeaiupdpa
(A) 352 (BY 1.5.2

C) 402 (D) 3.0.2

(E) Answer not known
e Gsflueldene
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